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I’ve got one that I salvaged years ago from a dump-
ster, with a loose belt clip I repaired with ‘liquid sol-
der’ and damaged battery terminal connections that 
required careful attention with long nosed pliers.  The 
beauty of this light was that, in virtually any situation, 
and tight working environments, with the swivel head 
and focusing beam, along with the Lightstick’s shape, 
belt clip, and hanging loop, you could find a way to 
place it and get light on the work area — even when 
you had to climb a pole to a cable terminal at night. 

Over the years, I acquired a number of Maglites,  
http://www.maglite.com  wonderfully rugged flash-
lights made from aircraft grade aluminum, with focus-
ing reflector systems that work quite well.  An outfit 
called Nite-Ize http://niteize.com/  supplies a variety 
of accessories to make the Maglites more versatile, 

(Continued on page 14) 

Are you a techtoyaholic?  I know I am.  When APCUG 
colleague Gabe Goldberg does his Gadgets Grabbag 
presentation for our user groups, I can’t sleep for three 
days, thinking about all those nifty toys!  See (July 2nd, 
2008 Mtg.) — http://www.nctcug.org/recmtgs.html  

I have a severe weakness for flashlights — size doesn’t 
matter, but lumens do!   I’m not sure if it’s a sup-
pressed fear of the dark (I’ve never liked horror mov-
ies), or that being quite nearsighted from about age ten, 
I’ve always wanted lots of light focused on whatever 
I’m working on.  My early favorite, from my career 
more than 35 years ago as a telephone installer / repair-
man, was a Lightstick, product of the Justrite Manufac-
turing Company:  http://snipurl.com/3l09s  Best de-
scribed as a slightly flattened steel can, it holds 4 “D” 
cells, has a swiveling head with a focusing reflector 
that allows spot or flood light diffusion, along with a 
belt clip, and a loop handle / hanger on the bottom.  
It’s still being sold, although a quick Internet search of 
about three companies showed the lowest price around 
$47.  That’s kind of pricey for a flashlight that still 
uses an incandescent lamp. 
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Does your computer go to sleep? By default, Win-
dows Vista was designed to go to sleep after an hour 
of inactivity. This feature is primarily designed to 
conserve laptop battery power. Microsoft estimates 
that allowing a PC to go to sleep during off hours, as 
compared to leaving it on all the time, saves any-
where from $55 to $70 a year so this feature has 
some value for desktop users. Of course the amount 
you save will vary depending on the type of monitor 
that you use and your local electric utility rates. Here 
in the Pacific Northwest, with our relatively low 
electric rates, I suspect that the savings will be some-
thing less than $55 a year but multiply that amount 
by the number of computer monitors that you have 
and you can probably fill your gas tank once or 
twice. ;-)  

With Windows XP, application programs can veto a 
user’s request for the PC to go to enter sleep mode. 
Consequently, laptop owners who thought they had 
put their computer to sleep, might discover a few 
hours later that the machine had remained on and the 
battery had been drained. Vista features a group pol-
icy tool that can enforce power management settings 
over the wishes of application programs. Vista’s new 
sleep option, allows you to wake up your computer 
to install security updates, while letting it remain in 
the power-saving mode the rest of the time.  

So how can you control this energy/battery saving 
feature?  

1) Go to your Control Panel and select the  
Classic View 

2) Double-click on Power Options 

3) The right pane of the Power Option Window 
shows the main power plans which are currently 
available or in use. In the top left pane of the 
Power Option Window you’ll see the following 
options: 

Require a password on wakeup is self explana-
tory.  

Chose what power buttons to use opens a new 
window where you can select implementing 
the sleep mode by pressing a sleep button, the 
power button or closing a laptop’s lid. Actu-
ally there are a number of options available 
here, including Hibernate and Shut Down.  

Choose what closing the lid does is similar to 
the above option (it even uses the same win-
dow).  

Create a power plan offers three basic plans 
plus an option to create customized plans.  

Choose when to turn off the display offers 
sixteen different time intervals to activate 
this feature.  

Change when the computer sleeps works 
the same as the turn off the display feature.  

Adjust the display brightness obviously 
controls the screen’s brightness and the 
amount of power consumed by the screen.  

So make your choice(s). Save power, your battery 
and the environment.  

On another topic, when I first tested the pre-
release version of Windows Vista I noted that file 
transfers seemed to be much slower than with 
Windows XP. This problem was not corrected 
when Vista was released to the general public. The 
problem becomes very noticeable when you try to 
transfer very large files from one partition to an-
other. Maybe it will be corrected when Vista Ser-
vice Pack 1 is released but, in case it isn’t, here’s 
how you can fix it.  

The cause for slow file transfers is apparently 
something called Remote Differential Compres-
sion which is used when files are transferred from 
one partition to another. The fix is to disable Re-
mote Differential Compression. How do you do 
that?  

Moving On To Vista – Part 7  
By Neil Stahfest, Shareware Librarian, Tacoma Area PC User Group, WA   
www.tapcug.org  ncstahfest(at)msn.com 

Obtained from APCUG with the author’s permission for publication by APCUG member groups 
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Using the arrow keys I selected Safe Mode and 
pressed Enter. I lucked out and it started in Safe Mode. 

Once in Safe Mode I decided to restore the system set-
tings to an earlier point in time  when everything 
worked correctly. In Windows XP every time you shut 
down your computer it takes a snapshot of your oper-
ating system settings and saves them into what is 

called a restore point. If you later 
install a program or get attacked by a 
virus that alters your system settings 
such that the machine no longer runs 
right you can in theory go back to 
some prior point in time when the 
machine ran correctly and restore the 
settings to what they were then. 
That’s called a restore point. Note 
that you have to uninstall the offend-
ing program or get rid of the virus 
before you attempt a restore. Other-
wise the program or virus will just 

alter your settings once again. Also note that going 
back to some prior restore point will not delete any 
files you created and saved after the restore point you 
select. You won’t lose any data. However, I had never 
tried this before so didn’t quite know what to expect. 

In order to get into the routine you do Start, Programs, 
Accessories, System Tools, System Restore. After 
clicking System Restore you select Restore my com-
puter to an earlier time, and then follow the prompts. 
The routine lets you choose a date you want to restore 
to. I had to think about that. It ran well the previous 
day, but that was the day the settings were changed. I 
chose to go back 2 days to be sure I was well before 
the bad thing occurred. I finished the restore procedure 
and the machine restarted perfectly. It turned out to be 
a really good use of the restore point feature in XP. 

I mentioned above that you must first get rid of what-
ever changed your settings in the first place before you 
do the restore. If you don’t then you risk that it will 
simply alter your settings once again and you’ll be 
right back where you were with a sick machine. In my 

(Continued on page 4) 

1) From the Start button, open the Control Panel.  

2) Go to the Programs and Features section.  

3) In the left pane select Turn on or off Windows 
features.  

4) Uncheck the option for Remote Differential 
Compression.  

That’s all there is to it! Enjoy your faster file  
transfers. 

This article has been provided to APCUG by the author solely for 
publication by APCUG member groups. All other uses require the 
permission of the author (see e-mail address above).  
 

Recently, while in a big hurry to get a lot of work 
done before leaving on vacation, my computer started 
up with a blank screen. No mouse, no images, no 
text, no error message, no nothing. I had no choice 
but to just shut it down using the on/off switch. I then 
tried to start it again, this time watching very care-
fully to see what happened (I was getting coffee the 
first time). It went through the BIOS start (black & 
white screens with text) OK; then gave a 
brief color flash of the Windows XP 
logo, then nothing. The hard drive activ-
ity light was flashing so I knew the ma-
chine was trying. I was encouraged by 
the Windows startup sounds, but never 
got an image. 

I recalled that the evening before I had 
received a warning from my computer 
security software that some program was 
trying to make a change to something it 
thought was a danger. I was in a hurry 
and I OK’d it without reading it thoroughly. Thinking 
back I decided that perhaps I had OK’d a bad thing 
that resulted in changing some setting in the operat-
ing system (Windows XP Home). I then crossed my 
fingers and tried starting the machine in Safe Mode. 
You do that by turning on the machine and then re-
peatedly pushing the F8 key until you get the black & 
white screen that lets you select the startup mode. 

Using A Restore Point 
By Larry Bothe, honorary member of the Fox Valley PC Association, IL  
Associate member of CAEUG, IL  www.fvpca.org  www.caeug.net  % deanholste(at)sbcglobal.net 

Obtained from APCUG with the author’s permission for publication by APCUG member groups 
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When selecting an anti-spyware program, start out by 
selecting one with a comprehensive signatures data-
base. The best anti-spyware programs have databases 
that can recognize more than 750,000 different kinds 
of spyware and Trojan Horse programs. Read the 
documentation or call the company. This is impor-
tant.  

The best signatures database won’t do you any good 
if it isn’t updated frequently. The bad guys never 
seem to rest. They release new poison daily. Don’t 
buy any solutions that require manual updates. You 
have better things to do. Insist on automatic updates.  

Another important capability is active monitoring of 
your system. Wouldn’t you rather prevent a mali-
cious program from installing rather than removing it 
after the damage has been done? Avoid any program 
that removes infections found only after conducting a 
manual scan. This probably means avoiding some 
otherwise adequate free programs. There’s an old 
saying about getting what you pay for. The best anti-
spyware programs prevent spyware and Trojan 
Horses from ever being installed on your system.  

For many years the most acute danger to your com-
puter was some kind of destructive virus. Today the 
danger has shifted from software that is programmed 
to destroy files, corrupt programs, and disable sys-
tems to something more insidious, and perhaps even 
more treacherous. This threat comes in two broad 
categories known as Spyware and Trojan Horses.  

Spyware started out as a stealth program surrepti-
tiously installed on your system to track your web 
surfing habits. The developers of spyware didn’t 
want to damage your computer. They wanted only to 
sell you something. That may be annoying, but there 
is nothing criminal about it.  

A Trojan Horse is a program that pretends to be 
something other than what it really is. For example, 
a screensaver could be designed to install a program 
that will take over your system to forward spam to 
other machines. Trojan Horses have been used to 
initiate denial of service attacks, where the target 
such as a bank, credit card service or other high pro-
file web site becomes so saturated with external re-
quests that it cannot respond to legitimate traffic.  

Evaluating Your Anti-Spyware Program 
By Vinny La Bash, Member of the Sarasota Personal Computer Users Group, Inc.  
www.spcug.org  vlabash(at)comcast.net  

Obtained from APCUG with the author’s permission for publication by APCUG member groups 

haste to fix my computer I didn’t take that corrective 
action, so when it restarted the malware once again 
tried to alter my settings. And once again my security 
software caught it and presented a warning. Being a 
bit smarter this time I clicked on Deny instead of Al-
low (OK). After the machine came up running prop-
erly I used my security 

software (Zone Alarm Security Suite) to do a full 
system scan for any malicious software. It did indeed 
find one bad thing (in addition to several spyware 
items), which I told it to remove. I guess that was it 
because I have had no more trouble. No, I can’t tell 
you exactly what the offending malicious software 
was because I didn’t write it down, and I have slept 
since then. 

I learned several lessons from this little episode. A 
good suite of computer security orograms is worth 
every penny you pay for it. Even cautious computer 
users like me can get caught up in a virus problem. 
When your security software presents a warning you 
need to pay attention; I won’t be so quick to click on 
Allow in the future. Finally, the System Restore fea-
ture in Windows XP is worth its weight in owl feath-
ers. It is easy to use and very effective under the right 
circumstances. 

Larry Bothe is an associate member of CAEUG and an honorary 
member of FVPCA. He was President of CAEUG for a time back in 
the 90’s when he lived in the Chicago area. Larry presently resides 
in southern Indiana where he is retired from the plastics industry 
and currently teaches people to fly airplanes. He also performs 
pilot examinations for the FAA. 
This article has been provided to APCUG by the author solely for 
publication by APCUG member groups. All other uses require the 
permission of the author (see e-mail address above). 

(Continued from page 3) 
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Beyond shutting down a process or resetting its prior-
ity, there isn’t much a non-specialist can do with this 
feature. Clever programmers can create spyware that 
won’t show up in the Process Manager. Any decent 
anti-spyware program has to have its own built-in 
process manager that will recognize, track down, and 
eliminate malevolent software that may not even be in 
the signatures database.  

Anti-spyware programs should be able to monitor pro-
grams that load when Windows starts up. There are 
many very sophisticated spyware programs that to not 
show up in the Process Monitor or in Control Panel’s 
Add/Remove section. If your anti-spyware program 
lacks this capability, find another one.  

Assuming your anti-spyware program has the capabili-
ties mentioned above, it is an excellent choice for indi-
viduals. However, businesses or organizations with 
multiple computers will require even more. Whoever is 
in charge of PCs will not have time to manually moni-
tor or administrate individual machines. It is simply 
impractical in a large organization for support staff to 
visit every workstation, apply updates, schedule scans, 
and ensure that infestations are removed. If this applies 
to you, look for a program with a centralized admini-
stration console. This capability has the unfortunate 

drawback of 
being quite ex-
pensive, but the 
time saved gen-
erally justifies 
the cost.  

This article has 
been provided to 
APCUG by the 
author solely for 
publication by AP-
CUG member 
groups. All other 
uses require the 
permission of the 
author (see e-mail 
address above). 
 

Go for a program that allows you to customize your 
scans. We don’t all use our computers in the same 
way. Some people require more comprehensive scans 
than others. If you are constantly browsing the inter-
net, you are likely to benefit from a daily scan that 
checks active memory, system folders, the registry, 
and all hard drives. If you rarely use the internet or 
find yourself visiting the same six sites over and over, 
a weekly scan may be all you need.  

You should be able to schedule unattended updates 
and scans. Your machine should be yours to use as 
you wish. Any decent anti-spyware program should be 
able to run in the background unattended, and not re-
quire interrupting your activities. The program should 
work according to your preferences, not the other way 
around. Choose a program that permits unattended 
maintenance and administration.  

It’s also important that an unattended scan can quaran-
tine infections without requiring intervention from 
you. Why do some anti-spyware programs ask if you 
want to remove infections? Of course you do! Of all 
the features in anti-spyware programs, that is the 
dumbest.  

There are innumerable derivations and iterations of 
spyware being created. This makes it difficult for even 
the best anti-spyware 
programs to catch and 
destroy them. If you 
open the Processes tab in 
Windows Task Manager, 
you will observe the 
Process Manager in ac-
tion. You will see a list 
of objects running on 
your system. Some of 
them are applications 
like word processors. 
Others are mysterious 
entities that don’t pro-
vide a clue as so what 
they do, but you can’t 
run Windows effectively 
without them. Among 
them would be Windows 
Explorer, Internet Ex-
plorer, Media Center, 
Windows Mobile Con-
trol Center, and many 
others.  
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Some computer products just have a ‘wow’ factor on 
first sight; the Pinnacle PCTV HD Stick is one of 
those devices. It is a TV tuner on a USB stick and not 
just any TV tuner but one that is capable of pulling 
down Standard Definition (SD) and High Definition 
(HD) content to your PC. On seeing the Pinnacle 
presentation on their PCTV HD Stick at the APCUG 
Convention in 2008, I have been itching to get my 
hands on one. I was imagining a new widescreen 
computer monitor coupled with this device as a 
means of having a really cheap HDTV. So I pur-
chased a new widescreen monitor (22") and the 
PCTV HD Stick. The USB device comes in 3 flavors, 
PCTV HD ($69.99), PCTV HD Pro ($99.99) and the 
top of the line PCTV HD Ultimate ($129.99). There 
is also an internal card version ($79.99).  All these 
devices are designed for Windows XP and are Vista 
Certified.  There is a separate device with similar fea-
tures for Mac users ($129.99). I opted for the 
‘Ultimate’ model because of its onboard memory 
DVR and software.  More on that later, but the Ulti-
mate is a plug and play that allows you to start watch-
ing and record SD and HDTV almost immediately.  

Packaging 

The packaging contains a mini remote control includ-
ing batteries, a portable telescoping high-gain an-
tenna, A/V adapter cable, A/V adaptor cable, a USB 
extender cable and the usual manuals and CDs. With 
the Ultimate model you also get a neat soft leatherette 
carrying pouch. 

Setting Up 

Setting up the PCTV Ultimate could not be easier. 
This model has all the software preinstalled including 
the Personal Video Recorder (PVR) that allows you 
to record up to 2 hours of video.  You just plug it in 
and follow the onscreen instructions and start enjoy-
ing live TV within seconds. The on-board memory on 
the Ultimate can also be used to store additional files.  
You run setup once, even if you use the device on a 
different PC, the settings and preference are stored on 
the device. 

You have 3 options in setting up the PCTV:  

1) Antenna (for digital/analog TV reception) 
2) Cable (analog TV reception) 
3) Capture from Cable/Satellite Set-top Box 

For this review we will be using Option 1 – Antenna 
(digital/analog TV reception). During setup, the 
PCTV will scan for SD and HD signals via the in-
cluded antenna. The antenna is designed for digital 
and analog TV reception in regions with fair to good 
signal coverage.  When using the antenna, it should 
be fully extended in the upright position as high as 
possible and near a window. The base of the antenna 
is magnetic so it should not be placed near a cathode 
ray tube monitor, television or similar equipment as 
the electromagnetic field of such devices might dete-
riorate the signal quality. Also be careful with the 
magnetic base around other objects that are sensitive 
to magnetic forces – i.e. PC hard drive. In my region 
I was able to download all the local SD and HD sta-
tions available within my region via the antenna. 

Software 

When you first install the PCTV HD Ultimate Stick, 
it checks whether all the required drivers and 
the .NET 2.0 Framework are already on your com-
puter and, if necessary, installs them.  After the initial 
startup, every time you start the program, a TV 
screen appears immediately on your desktop. The 
integrated memory on the PCTV HD Ultimate Stick 
is divided into 2 different areas or drives.  

~ A re-writable memory area (removable media 
area) with the TVCenter Pro program and avail-
able memory for recorded shows or other user 
data. The drive is labeled PCTV flash. 

~ A read-only memory area (CD-ROM area) con-
tains the drivers. This drive is labeled PCTV 
Start. 

Also included in the package is Pinnacle Studio 
QuckStart that allows you to edit your recordings or 
home movies and transfer them to DVD, complete 
with custom menus and soundtracks. 

Review: Pinnacle PCTV HD Ultimate Stick  
By Bill James, APCUG Director; Editor & Webmaster, Computer Club of Oklahoma City  
www.ccokc.org  bjames(at)apcug.net  

Obtained from APCUG with the author’s permission for publication by APCUG member groups 



October 2008    The NCTCUG Journal Page 7 

www.nctcug.org 

can also opt to purchase a compatible Media Center 
Remote control that is available from Pinnacle for 
$29.99. Again, to get the PCTV HD stick to work with 
Windows Media Center is the matter of selecting the 
TV setup in Windows Media Center and following the 
onscreen instructions. Window Media Center will rec-
ognize the device and do its own scan and download a 
TV guide that is used to identify the channels and for 
time shifting. The time shifting feature allows you to 
record your favorite TV shows and play them back at 
a later time.  Windows Media Center does not support 
some of the onboard memory features of the PCTV 
HD Ultimate stick. 

Conclusion 

I now have my cheap HDTV and so far I have not 
been disappointed.  The PCTV HD is pulling free off 
the air HD signals and displaying them on my monitor 
in full HD. The PCTV HD Ultimate Stick is a slick 
ultra-portable USB device that will allow you to 
watch and record SD and free HD TV.  The TV tuner 
and personal video recorder software run directly from 
the Stick’s on-board flash memory, so you can plug it 
into any PC and start watching and recording TV in 
seconds – no installation required.  

It supports both analog (NTSC) and digital (ATSC) 
TV signals. The tuner hardware is also ready for 
ClearQAM (unencrypted digital cable).  

You can record up to 2 hours of TV directly to the 
stick for playback on any PC and save recordings to 
your hard drive in MPEG-1/2 or DivX formats or even 
direct-to-DVD.  

This article has been provided to APCUG by the author solely for 
publication by APCUG member groups. All other uses require the 
permission of the author (see e-mail address above). 

Controls 

The package comes with a full-featured remote con-
trol. Although small in size it does give complete con-
trol of the PCTV. If you elect to use Windows Media 
Center, the included remote will not work. You will 
have to purchase a compatible Windows Media Cen-
ter remote that is available from Pinnacle. 

Display 

The first time Pinnacle TVCenter Pro is accessed, you 
will see the Player.  This screen can be full-screen or 
resized to suit. There are navigation icons that select 
settings, channels, TV or Radio and the program 
guide. 

FM Radio 

As sort of an added bonus, during setup PCTV stick 
also scans for available internet radio signals for play 
back on your PC. It categorizes them by genre rather 
than call letters. Unfortunately, the software does not 
provide any other information regarding the available 
stations or for the music that is being played. 

Picture Quality and Sound Quality 

The quality of picture and sound is dependent on your 
monitor and speakers. The PCTV HD stick is capable 
of providing digital sound, SD and HD quality picture 
that if is available within your region.  

Windows Media Center 

If you have a PC equipped with Microsoft Windows 
Vista Home Premium or Ultimate or Windows XP 
Media Center Edition 2005 and you want to watch 
and record TV using the Windows Media Center ap-
plication, then you will have to run TV setup in that 
application. I’m running Windows Vista Ultimate on 
my PC and using the Windows Media Center soft-
ware for my TV viewing and recording, but you can 
use either product. There is not a conflict between the 
included software and Windows Media Center. How-
ever, the Windows Media Center software overrides 
the included TVCenter Pro software for TV viewing 
and recording. The included remote does not work 
with Windows Media Center; however you can select 
channels directly by keyboard input and/or by mouse 
when viewing TV via Windows Media Center. You 
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The tech support effort involved major system modi-
fications including deletion of all files associated 
with my original EMC version 9, my Nero burner 
software, a complete registry purge line by line of 
anything remotely associated with or influenced by 
Roxio software, removal of all anti-virus software 
and firewalls, elimination of all startup files except 
system essentials and running registry clean utilities. 
Nothing worked! A trouble report was left open but I 
never received any further calls. In their users forum 
I did find one other person with the exact same prob-
lem and no solution.  

Fortunately I have a couple of other computers at my 
house so I tried installing the version 10 on both an 
older desktop and on my primary laptop system. The 
install went smoothly on both of those systems. So 
until I get a chance to rebuild my primary desktop I 
won’t know if I can ever use the latest version on it. 
On a side note before trying to install EMC version 
10 I had version 9 successfully working. After all the 
system changes I could no longer load my EMC ver-
sion 9. So now I struggled with that problem for a 
few days. Once again not finding any online solutions 
I contacted a phone support tech who was able to di-
rect me to a download utility that cleared the problem 
and allowed me once again install version 9. 

While the above debacle was frustrating don’t let it 
deter you from considering the purchase of this capa-
ble applications suite. So let’s look at why you 
should consider owning this product.  

Once you get past the install you will see a super 
clean interface with applications divided into seven 
primary areas; Audio, Data and Backup, Copy, Me-
dia and Devices, Photo, Video, and Tools. Each ap-
plication provides another set of choices. Audio has 
(13), Data and Backup (5), Copy (5) Media and De-
vices (2), Photo (9), Video (11), and Tools (8). Now 
that is a huge chest of applications at your disposal.  
If you were to purchase each primary application 
separately it would cost you a few hundred dollars. 
This package sells for about $100 but if you watch 
for sales you can buy it for much less.  

Roxio, a division and brand of Sonic Solutions, has 
been a leader in burning software for many years. I 
personally have used the product since it was distrib-
uted by Adaptec several years ago. The CD/DVD 
burning software today far exceeds the basic functions 
that existed in those early days. Roxio Easy Media 
Creator (EMC) will accomplish so much more than 
the basic burning tasks and is now a full featured 
suite. 

Doing this review has allowed me to explore and ap-
preciate the many applications within this suite. Be-
cause EMC is so comprehensive I will provide an 
overview in this article but follow up with more de-
tails in future issues of our newsletter.  

Before I start boasting about some of these neat appli-
cations I must discuss some installation issues. The 
product would not install on my primary computer! 
After trying several times to install under various sce-
narios I checked for possible solutions using Roxio’s 
web product support and also their user forum. None 
of those sources provided any clues so I connected 
with technical phone support. I was quite surprised 
that the wait time was very small and the technician 
was professional and extremely competent. Unfortu-
nately after almost two hours of phone support the 
problem was not solved. 

Review: Roxio Easy Media Creator Suite v.10 
By John Roy, President, The PC Users Group of Connecticut   
www.tpcug-ct.org  johnroy1(at)comcast.net 

Obtained from APCUG with the author’s permission for publication by APCUG member groups 
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The Video application is another full featured suite 
for importing, editing, customizing and exporting 
video into various formats. Included is CinePlayer a 
full featured video player. The features are similar to 
those found in Pinnacle Studio or Adobe Premier. 
While some of Roxio EMC tools are not as robust as 
the leaders you will find some tools not available in 
the others. It may not be as flexible as the stand alone 
programs but it will be easier for the novice. If you 
are a true video buff then even if you own other video 
software you would also want to have EMC in your 
software chest. 

The smallest stand-alone module is Media Manager 
that enables users to easily browse, manage, share and 
protect their media files. The final application module 
is Tools. This module is used for creating disc labels, 
obtaining drive information, erasing discs, creating 
virtual disc drives and a few other assorted utilities.  
Roxio EMC is Vista compatible and includes gadgets 
for doing things directly from the desktop. 

I’m certain most computer users will find enough ap-
plications on Roxio Easy Media Creator to make the 
investment worthwhile. If this review has captured 
your interest pay a visit to Roxio’s website at  
http://www.roxio.com/. They have some great videos 
that will demonstrate these neat features 

This article has been provided to APCUG by the author solely for 
publication by APCUG member groups. All other uses require the 
permission of the author (see e-mail address above). 

When you think of Roxio and burning software the 
primary reason most people purchase the product is for 
those tools. The Copy and Data and Backup modules 
take care of those basic requirements along with some 
other goodies. For anyone familiar with an older ver-
sion, you will still find the original Creator Classic still 
there but spruced up. That old standby is quite the 
workhorse. You select the type and size of disc you 
want to burn and it will keep you updated on available 
space as you move files or folders you want to burn 
into a holding area. Once your files and folders are se-
lected you can burn your CD/DVD directly or make an 
image for later burning. Of course you have advanced 
options to define the type of disc, speed, copies, etc. 
You can also make a bootable or multimedia disc and 
go directly to creating disc labels of your burn project. 

The backup module provides capability to be selective 
of the files you want backed up or restored and at what 
frequency. If you want more powerful options then you 
will be provided an upgrade link. A range of backup 
devices and media including Blu-ray discs and HD 
DVD discs are supported. Large files can be automati-
cally spanned across multiple discs as required. 

The Audio module provides thirteen selections that 
cover just about everything you could possibly want to 
do with audio. All the expected tools are there to rip 
CD’s into MP3 files or create audio CDs from other 
formats. You can make custom CD’s with fades, ef-
fects and mixing. Tools are there to edit song informa-
tion and to do batch conversions to formats of your 
choice. One module allows you to instantly capture 
any audio playing on your computer, including 
streaming radio. There is one utility “Convert LPs 
and Tapes” that I was especially enthused about. At 
our meeting we have had the question of how to 
convert LPs and Tapes asked many times in the 
past. While there are several methods to accomplish 
this, Roxio EMC has made it easy and crystal clear 
with this application. So for those of you that have a 
desire to do this you should give Roxio EMC seri-
ous consideration. 

The Photo application contains a full featured photo 
suite with powerful editing, effects and touchup 
tools. It is complete with all the ancillary things you 
want to do with photos such as creating slideshows, 
panoramas, albums, greeting cards, calendars and 
layout templates. You can quickly optimize a group 
of photos for sending email.  



Page 10 The NCTCUG Journal October 2008 

www.nctcug.org 

The second thing to do to make a photo e-mailable is 
to save it in JPEG format (.jpg). That is a format 
that reduces file size a lot and picture quality a little 
so the picture can be downloaded more quickly and 
still be nice to look at. Some software programs give 
you choices of compression amount with numbers 
ranging from 1 to 10. One will result in a very small 
file but the picture quality will not be good at all. A 
10 will give the very best quality but with a very 
large file size. A reasonable compromise is to use 5 
or 6. I usually use 6. 

How do you do this? First, I will describe how to do 
it with a free Microsoft program. Then I will try to 
look at some other programs. 

Microsoft Power Toys for XP has a Resize Pictures 
toy that is slick and easy but feedback says it only 
works on XP. It can be downloaded at http://
www.microsoft.com/windowsxp/downloads/
powertoys/xppowertoys.mspx. Right click on an im-
age name or thumbnail in Explorer or My Computer 
and choose Resize Pictures. You are limited to four 
specific sizes but they are good choices. They don’t 
tell us what compression they are using but the re-
sults look OK. Unless you tell them under Advanced 
to replace the image in the file, it will make a copy. 
That’s good. They will add the word, “Large”, 
“Medium” or “Small” to the end of the name you 
have chosen. 

First, we must understand that photograph (image) size 
in the camera and in the computer is measured in pix-
els. These are the basic dots of color that make the pic-
ture. Do not pay any attention to anything that says 
“inches” or “pixels per inch.” These terms are mean-
ingless when we are considering a picture either in the 
camera or in the computer. They may come into play 
later if we want to print the photo on paper. But, that is 
another subject for another time. For now, we think 
only of pixels. Most cameras record too many pixels to 
e-mail. For instance a 6 megapixel camera will make a 
picture about 3000 pixels wide by 2000 pixels tall and 
the file size may be several megabytes. Our screens are 
usually only about 1000 pixels wide (some are larger 
and some smaller). So, if we e-mail the native picture, 
it will be wider than the screen for the recipient and the 
file will be so large, it may take “forever” to download 
to the recipient’s computer. It is possible the service 
provider will not even accept it. 

There are two things we must do to make a photo e-
mailable. The first is to resize or resample the picture. 
We want to change the picture width from 3000 pixels 
to 800 pixels, for instance. This process is called resiz-
ing or resampling. We have to pick the best 800 pixels 
out of the 3000 to represent our photo. Well, no, that is 
not exactly correct but it simplifies things to think of it 
that way. We don’t have to worry about it because a lot 
of very smart programmers have developed ways 
(algorithms) to help us. Just remember, you want to 
resize or resample to get the photo down to a size con-
venient for e-mailing. I usually use 800 pixels or 900 
pixels width for pictures I attach to e-mails. 

E-Mailing Photographs 
By Richard Kennon, Editor, Amador Computer Users Group, CA   
www.acug.net  Drtrdguy(at)volcano.net 

Obtained from APCUG with the author’s permission for publication by APCUG member groups 
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to use than Elements. First, click on Tools>Options> 
E-Mail. Then select the width you want in pixels. 
There are six choices. Then click on Apply and OK.  

The next step is to click on File>E-Mail and you will 
get three choices of how you want to e-mail your 
photos. Fortunately, I use Outlook Express so my 
choice is listed. 

When I clicked on Outlook Express, an e-mail page 
popped up with the photo attached. At this point we 
can write something else on the e-mail and send it. I 
recommend this so the recipient will know it is really 
from you and not something sent out by a virus. 
When I receive e-mails that only say “Attached”, I 
Delete them without looking at the attachment. This 
saved me one time when I received a virus from my 
sister-in-law that she did not know she sent. She 
spent weeks and dollars getting her computer back 
up. Oh, I digress. If you want to send more than one 
picture (and, who doesn’t?), you must select the pic-
ture and click on the Hold button near the bottom of 
the screen. Do this for each photo you want to send 
and they will all be attached to the e-mail. The pro-
gram automatically chooses JPEG format and a com-
pression ratio but does not tell you. That is OK as the 
pictures I tried looked good. Picasa2 has considerable 
capability for editing photos in many respects. Try it! 

There are many other editing programs that I haven’t 
mentioned and have no experience with. In all cases 
you want to change the picture’s size in pixels by 
resizing or resampling. Pay no attention to anything 
that says “inches” as that will have no meaning for 
this process. Sometime later we will talk about print-
ing pictures and then we will use inches. 

This article has been provided to APCUG by the author solely for 
publication by APCUG member groups. All other uses require the 
permission of the author (see e-mail address above). 

If you are happy with this solution, then read no fur-
ther. But, if you want to use a picture editing pro-
gram, maybe this will help. 

Photoshop Elements 

In Photoshop Elements 5, click on Image>Resize> 
Image Size and this window will pop up. Note that 
there is some garbage at the bottom about “inches” 
but we will ignore that. First we will click the Re-
sample Image box. That puts the Pixel Dimensions 
in play and that is what we want. I selected the Width 
box and changed the width to 800 pixels. Since the 
Constrain Proportions box is selected, that is all I 
have to do.  

Note, down at the bottom, that we have several 
choices of sampling algorithms. This is frosting on 
the cake. I read somewhere that I should use Bicubic 
Sharper when downsizing so that is what I do. Most 
programs don’t give us all these choices. Then we 
should click on File>Save As and give the photo a 
new name. I often just use the same name and add 
“_800px” so the next time I will know it is ready to 
e-mail. Here we can choose the JPEG format and the 
compression amount. Photoshop Elements 6 is out 
now and sells for about $100. If you are able to spend 
that much and want one of the best editing programs, 
I highly recommend it. 

Picasa 
Let’s look at Picasa2. It is a free program from 
Google and looks really good but I do not have much 
experience with it. By all means, try it first because 
the price is right! When it comes to e-mailing photo-
graphs, it is a little more automated but not any easier 
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For anybody who has thought about trying Linux, it 
has become easier than ever before with Ubuntu 8.04 
LTS Hardy Heron. As with most Linux distributions, 
Ubuntu is available as a free download and is freely 
distributable. It is even available already installed on 
Dell computers. The most common method is 
downloading the ISO image from Ubuntu’s website 
(http://www.ubuntu. com) and burning it onto a CD. 

From the site, you can download the Desktop version 
or Server for 32-bit and 64-bit systems. There is even 
an option to download what is called an alternative 
version which is just the installer and does not in-
clude the LiveCD portion, which also includes an 
installer. If you are like me, until a couple months 
ago, and living on dial-up or you do not have a CD 
burner handy or just don’t want to put in that much 
effort then you can order a free CD through the cor-
porate sponsor of Ubuntu, Canonical, ShipIt depart-
ment. 

I have been very pleased with the speed with which 
their CDs arrive. Alternatively, the website contains 
links to vendors where you can buy the CDs from 
under $5 to more, and they can handle large orders as 
well.  

Once you have your CD in your hot little hands, try-
ing Ubuntu is as simple as placing it in your CD-
ROM tray and rebooting your system. If system will 
boot from the CD and after a short moment you’ll be 
greeted with the Ubuntu welcome screen. 

If you want to “try before you buy,” then you can 
choose the default “Try Ubuntu without any changes 
to your computer” and your hard drive will not be 
touched during your session unless you choose to. 
You don’t even need a hard drive to select this op-
tion; you just will not be able to install it from the 
session. 

If you are more certain or just daring then you can go 
straight into the installer and in about 60 minutes (45 
minutes if you know what Different Strokes For Any-
body Who Has Thought About Trying Linux by 
Drew Kwashnak you are doing) you’re booting to 
your new Ubuntu installation. 

Ubuntu will scan your hardware and load the mod-
ules and drivers necessary for your system. If you 
have hardware that has proprietary drivers available, 
Linux cannot include them in the CD for legal rea-
sons. Ubuntu works around this by providing a Re-
stricted Drivers tool that lists all such hardware found 
on your system and provides the ability to download 
and install the necessary drivers in a click or two, 
legally.  

Now that you have Ubuntu up and running on your 
system, what can you do? Plenty! Ubuntu brings you 
a fullfeatured operating system complete with: 

• Firefox 3.05 beta web browser 

• OpenOffice.org 2.4 full featured office suite 
compatible with pre-Office 2007 Word, Excel, 
PowerPoint and some Access files. 

For Anybody Who Has Thought About Trying Linux 
By Drew Kwashnak, Linux SIG Leader, Danbury Area Computer Society, CT   
www.dacs.org  dacseditor(at)dacs.org 

Obtained from APCUG with the author’s permission for publication by APCUG member groups 

Washington Area User Group Partners 
Working Together For Our Members 

NCTCUG.ORG  WACUG.ORG  
CPCUG.ORG 

For more information see: 

 http://www.nctcug.org/waugp.html 

Washington Area Computer User Group  
WACUG Meeting will be held on October 18, 2008  from 
12:30 to 3:30 pm . at the Fairfax County Government Cen-
ter,  2000 Government Center Parkway, Fairfax, VA   

You do not need to be a member to attend.  For more 
information on WAC meetings and events, call the  
WAC AnswerLine (voice) at (703) 370-7649.  
Also see WAC’s Web Site at 

http://www.wacug.org/ 
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staller for Windows users that can bring you to the 
Linux world with a single click. Wubi allows you to 
install and uninstall Ubuntu as any other Windows 
application, in a simple and safe way. Are you curious 
about Linux and Ubuntu? Trying them out has never 
been easier!” 

Wubi can be downloaded as an .exe file directly. With 
Linux the installation is not the end, only the begin-
ning!  

Whether you try the 
LiveCD, Wubi or a 
full installation you 
will find a wealth 
of quality appli-
cations, refresh-

ing freedom and a 
community unlike 
any other!  

If you have problems, questions or want to 
find out more then you need look no further than 

the third Wednesday of every month for the DACS 
Linux SIG at 7:30 p.m. in the DACS Resource Center! 

Links 

Ubuntu: http://www.ubuntu.com 

Get Ubuntu: http://www.ubuntu.com/getubuntu 

ShipIt: https://shipit.ubuntu.com/ 

Drew Kwashnak: Has been losing more nights of sleep with Linux 
since 2002 and just can’t keep from downloading and trying the 
latest versions! When not working with Linux he works with 
ASP.NET and Microsoft SQL Server for a small financial company. 
He is also the DACS Linux SIG leader and a father of 3. 
This article has been provided to APCUG by the author solely for 
publication by APCUG member groups. All other uses require the 
permission of the author (see e-mail address above). 

• Evolution personal information manager for email 
and calendar goodness, a Microsoft Outlook user 
can feel comfortable with. There is even plug-ins 
to allow Evolution to access existing Microsoft 
Exchange servers. 

• Pidgin multi-protocol instant messenger including 
Yahoo, MSN, AIM, Jabber, IRC and more. 

• Gimp (GNU Image Ma-
nipulation Program), a 
powerful Photoshop-like 
image editing program 
that includes filters, layers 
and a host of goodies. 

• F-Spot image 
manager for 
categorizing 
and minor edit-
ing of all of your 
pictures as well as 
easily importing 
pictures from your 
digital camera. 

• And much, MUCH more… 

If Ubuntu doesn’t come with a particular application, 
thousands of free applications are available from the 
Ubuntu online repository which are easily installed 
and updated from the Synaptic package manager.  

When you decide to install Ubuntu onto your hard 
drive or virtual machine you only need to click the 
“Install” icon on the desktop to start the process. After 
seven or so easy questions the installer will copy the 
files over to the hard disk. Depending on your sys-
tem’s speed this could take about 60 minutes, more or 
less. It will even detect if you have Windows installed 
and offer to transfer over your files and compatible 
settings from your Windows accounts! 

Of course, if the limitations of the LiveCD, such as 
settings are not saved from session to session, and you 
are hesitant to partition and install the full operating 
system on your hard drive Ubuntu offers yet another 
alternative called Wubi. Wubi is, from the Ubuntu 
website: “Wubi is an officially supported Ubuntu in-

Club Election Notice 
The NCTCUG Annual Meeting and election  
of officers and board members will be at the 
October meeting — October 1, 2008, 7 p.m.  
at Carlin Hall. 

Anyone interested in running for office, please 
contact any board member. All officers and 
four board positions are to be voted on. 
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with various options for getting the light on the work, 
multi-tool pouches, etc.  I was disappointed by their 
modification for the Mini-Maglite (2 AA cells) that 
added a switch and an LED in place of the regular hi-
intensity lamp.  It may have extended battery life, but 
seriously degraded the unit’s brightness. 

A friend with a serious SCUBA diving hobby gave 
me an Underwater Kinetics UK4AA, a rugged, plas-
tic cased flashlight using, not surprisingly, 4 AA 
cells.  This flashlight is only slightly larger than the 
MagLites that use 2 AA cells, and typical versions 
mount on diving masks and firemen’s helmets.  UK 
offers a broad range of flashlights for a variety of 
demanding uses.   
http://www.uwkinetics.com/product/69 

Over the last few years, the availability of high inten-
sity LEDs have spawned an explosion of flashlights 
of various shapes, sizes, and battery requirements.  
New and brighter flashlights make regular appear-
ances at user group meetings, although we’ve yet to 
see the tactical flashlights sold for military and police 
use — read “blindingly bright” and “expensive”.  
There are also lights with built-in, hand crank genera-
tors that I have several models of, carrying the Dura-
Pro label.   Lighting products from this company now 
carry the MegaBRITE brand.  
http://durapro.com/mb_home.html 

Recently, I was again tempted by a small flashlight 
that seemed to offer significant brightness from a sin-
gle AA cell.  Hanging at the checkout (impulse buy! 
— guess why there are never enough cashiers at a 
store with lots of toys at the check stand?) at Lowes 
was a “LED Lenser” by Coast Products, a maker of 
knives, tools, and lighting products.  http://
snipurl.com/3lcfc  

(Keeping Up…Continued from page 1) Our friend Mel Mikosinski seems similarly fasci-
nated with LED lighting products.  At an August 
meeting, he showed the gang an impressive collec-
tion of LED lights for use around the home, acquired 
at BJ’s Club and WalMart.  Several were of the  
“hockey puck” variety, designed for use under 
kitchen counters, in cabinets or closets.  These allow 
illumination in places that may resist wiring for AC 
lamp installation.  http://snipurl.com/3lcmq  

Other products included a tiny “camp lantern” and a 
variation of the “hockey puck” lamp on a stalk, that 
Mel touted for use in power blackouts.  Having re-
cently experienced a nine hour power interruption, I 
could really appreciate the attraction! 

What really got my attention, and caused me to race 
out to BJ’s the next day — after bribing my wife to 
accompany me with a visit to a nearby restaurant, 
were “LED Micro Task Lights.”  These seemingly 
are an ideal solution for lighting a laptop keyboard 
when giving a presentation in a darkened room.  I 
have several other LED lights I’ve acquired over the 
last five years for that purpose, and they were basi-
cally flawed.  While operating power supplied via a 
USB port is certainly a plus, the lights I’d previously 
used provided insufficient illumination, and were 
awkward to use. 

This unit is about the size of a deck of cards, with 
two telescoping stalks that support the light bar con-
taining the LEDs.  Powered by  three AAA cells, it 
has clips to attach to a laptop screen, a wire bail for 
attaching to a book page — tho’ I doubt you’d want 
to move it as you read each page, and even magnets, 
to attach to a metal surface.  At two to a package for 
ten bucks, these are, I think, a bargain — especially 
since it included six Duracell batteries.  Unfortu-
nately, this unit isn’t shown on the packager’s web 
site yet — model LPL904.  http://snipurl.com/3ld6p  

Another product from the same company (Leader & 
Loader Group) are called Wireless LED Task Lights, 
using 6 LEDs and the same complement of AAA 
cells (tho’ not included in the package) and come two 
to a blister pack for $20 - model LPL616 .  These can 
sit on a desk or table, and also come with a spring 
clip for attaching to shelf edges, for example.  I plan 
to use one for illuminating the controls on my home 
theater receiver, which are difficult 
to see in the subdued lighting normal 
in the room.  Thanks for finding 
these treasures, Mel !!  
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With the current power options (turn off the monitor 
after “20 minutes” and sleep “after 2 hours”) the com-
puter will wake up and get updates as well as run the 
scheduled backups. So with a simple change to a 
power option, I was able to reduce power consumption 
by approx 76% and save $5.93 per month with out af-
fecting my user experience. 

I plan on testing my XP machine next to see what it is 
costing and to see if it can be reduced. Thanks go to 
Louise and the rest of the group for a great discussion 
on energy use. (Louise is a SCUG Board Member at 
Large.) 

To get more info and tips on energy savings try one of 
Louise Dieden’s favorite links:  
http://www.energy.gov/forconsumers.htm 
This article has been provided to APCUG by the author solely for 
publication by APCUG member groups. All other uses require the 
permission of the author (see e-mail address above). 

(Green….Continued from page 16) Just Can’t Win Department 

I hate to own up to how inconsistent my exercise 
program is — though I’m sure it’s obvious from the 
extra thirty pounds floating about my navel.  Some 
time ago, I got a combo 13" TV and VCR from Cir-
cuit City — the plan being to record the “Nightly 
Business Report” at 6:30 PM every evening, Mon–
Fri, on WETA, and then play it back during my nor-
mal (read — if I get around to it!) session on the 
treadmill the next morning. 

My treadmill time was so infrequent that I didn’t get 
to the bottom of why I had a lot of extraneous mate-
rial on the tape, and the Business Report was so hard 
to find.  I kept checking the programming page of 
the VCR, where I had Monday through Friday set up 
to record from 6:30–7:00 PM — or so I thought.  I 
finally found the glitch — on Wednesdays, the end 
time was set to “7:00 a” rather than “7:00 p” so the 
recorder would run until the next morning — or the 
end of the tape, which ever came first!  At the dis-
tance from which I normally watch the TV, the dif-
ference between “a” and “p” wasn’t really apparent. 
I think I shoulda stood in bed. <grin> 
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COMPUCENTER BBS 
Is no longer in operation. It has 
been replaced by the 
‘compucenter’ mailing list at  
http://groups.yahoo.com/group/
compucenter/ 

If you are moving 
Please send your change 
of address to the club 
address as soon as 
possible to avoid 
missing issues. 

Thank You! 

NCTCUG, Inc. 201 S. Kensington St. Arlington VA  22204-1141 
Club Information call: 301-577-7899    Web Site: www.nctcug.org 



During our June program, there was quite a discussion 
about whether to leave your computer on verses shutting it 
off when not in use. 

I, personally, like to leave my computers run so they are 
kept up-to-date with auto updates and backed up with 
scheduled backups. These tasks are done in the early AM 
so my computers are fully functional when I sit down to 
use them. 

However, others asked why not just leave them on the 
nights that the backup runs instead of 24/7. I didn’t think it 
was using much energy by running 24/7 but decided to 
check it out and run some tests using my “Kill-A-Watt” 
meter. (Measures watts, amps, hours, kill a watt hours, etc.) 
I started with my newest computer (which is approx 2 
years old and probably the most efficient). This machine is 
running Vista and I had the Power Options set to turn off 
the monitor after “20 minutes” and put computer to sleep to 
“never”. With these settings the computer was drawing 
between 110 and 140 Watts of power with a total average 
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October 2008 
1st Wed. (10/1)   
7 p.m. Annual Meeting & Club Elections! 

4th Wed ( 10/22)   
7 p.m. Internet SIG 

3rd Monday (10/20) 
7 p.m.  Board of Directors  

All meetings are at Carlin Hall, 5711 S. 4th St., 
Arlington VA: East off of Carlin Springs Rd, just 
south of Arlington Blvd/Route 50. 

Going Green 
By Jerry Grommes, Past President, Sandwich 
Computer Users Group, Illinois   
www.scug.org  ggrommes(at)indianvalley.com 

Obtained from APCUG with the author’s permis-
sion for publication by APCUG member groups 

of 2.63 KWH (kill-a-watt hours) per day. Cost per 
day was $.026 ($7.87 a month) based on my most 
recent bill. 

I then changed the Power Options to turn off the 
monitor after “20 minutes” and put computer to 
sleep “after 2 hours”. 

The watts dropped from between 110 and 140 
while I was using the computer to 6 while in the 
sleep mode and the total average of KWH 
dropped to 0.65 per day. Cost is now down to 6 
cents a day ($1.94 a month). 

(Continued on page 15) 


